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Tietomalliklinikka Sessio 4

Revit 2025 - Solibriin (IFC -ominaisuuskartoitus)
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1 - Custom IFC -ominaisuudet Revitissa Shared Parametersin kautta

Tama dokumentti osoittaa selkedn, yksinkertaisen ja kdaytanndllisen menetelman, joka varmistaa
oikeat IFC-tiedot ilman manuaalisia muokkauksia. Se myos estaa virheet ja parantaa rakenteellista
tietoa Solibrissa, ja on yksinkertainen tyonkulku, joka on taysin hallittavissa Revitin valikoiden kautta.
Lopuksi luomme Custom User Defined Property Sets txt -tiedoston, joka mahdollistaa IFC-
ominaisuuksien, tasojen ja arvotyyppien tarkan hallinnan.

IFC Property Set Skeema (Muistutus Session 2:sta), koostuu kuudesta komponentista:

- . . . . * PropertySet: FI_RH1 T IfcBuilding
* Ominaisuusryhman maaritelma (PropertySet definition)

RakentamistoimenpiteenTyyppi IfcLabel

* Ominaisuusryhman nimi (PropertySet name) +  PasasiallinenRakentaja IfcLabel

* Soveltuvuus (Property Applicability):
* PropertySet: FI_Huoneisto | IfcSpace
Revitissa: Instance tai Type ) )
Archicadissa: IfcElement tai IfcTypeObject Tyyppt ffctabel Tian Lyyppl: Huoneistoala

Kéayttotarkoitus IfcLabel

Liitetty entiteetti

* PropertySet: Pset WallCommon | IfgWall

+ Ominaisuuden maaritelma (Property definition)

LoadBearing Boolean
+ Tietotyyppi (Data type) +  FireRating IfcLabel

Acoustic Rating  IfcLabel

Seuraavassa taulukossa on erilaisia ominaisuuksia, hierarkiatasoja ja yksikoitd. Kdytamme esimerkkina
8 eri ominaisuutta.

Revit Shared Parameter IFC Property (Solibri) Hierarchy Tietotyyppi Example Value
Level (Data Type)
Kunta FI_Kiinteist6.Kunta IfcSite IfcLabel 186 - Jarvenpaa
Suunnitteluala FI_Suunnittelija.Suunnitteluala IfcBuilding IfcLabel ARK
Itdkoordinaatti_ETRS89-GK25 FI_RakennuksenSijainti.ltakoordinaatti IfcBuilding IfcLabel 25504524.239 m
Pohjoiskoordinaatti_ETRS89-GK25 FI_RakennuksenSijainti.Pohjoiskoordinaatti IfcBuilding IfcLabel 6704386.689 m
Kayttotarkoitus FI_Huoneisto.Kayttotarkoitus IfcSpace IfcLabel Asunnot
LoadBearing Pset_Wall_Testi.LoadBearing Ifcwall IfcBoolean TRUE/FALSE
Compartmentation Pset_Wall_Testi.Compartmentation Ifcwall IfcBoolean TRUE/FALSE
FireRating Pset_Wall_Testi.FireRating, Ifcwall, IfcLabel El 60
Pset_Window_Testi.FireRating, IfcWindow,
Pset_Door_Testi.FireRating IfcDoor
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1.1 Korkein hierarkian taso: IfcSite
@ Luo ensimmainen mukautettu ominaisuusjoukko Revit 2025:ss4:

1.1.1 Kunta - Fl_Kiinteisto (New Group), Kunta (New Parameter)
v Data Type: Text (tdma on sama kuin IfcLabel)

v Hierarkian taso: IfcSite (maaritamme tason myéhemmin User Defined Property Setin kautta).
v Esimerkin arvo:186 - Jarvenpaa

¢ Valikon polku:

Manage > Shared Parameters > New Group > New Parameter

Edit Shared Parameters X

Shared parameter file:
C:\Yordi_Documents_LOCAL\Teriojantie 6\Tericjan Browse... Create...

Parameter group:
FI_Kiinteistd

Parameters:
A
New...

Properties...
Move...

Delete

Groups
New...
Rename...
Delete
oK Cancel Help
Parameter Properties X
Name:
Discipline:
Data Type:
Tooltip Description:
OK Cancel
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Taman jalkeen meidan on tuotava tama Project Information -valikkoon Project Parametersin kautta.

¢ Valikon polku:

Manage > Project Parameters > New Parameter > Parameter Type > Shared Parameter > Select

Valitse alasvetovalikosta ryhma Fl_Kiinteisto ja Kunta-parametri.

Shared Parameters X

Choose a parameter group, and a parameter.

Parameter group:

FI_Kiinteistd

Parameters:

Edt...
0K Cancel Help

Maarita tama parametri luokalle, tassa tapauksessa Projektin tiedot. Kaikki RH1-metatiedot
voivat sijaita samassa kentassa, esimerkiksi IFC-parametrit (voit valita haluamasi).

Parameter Properties

Parameter Type Categories
Project parameter Category name search:
(Can appear in schedules but not in tags) Fiter list: | <multiple>
© Shared parameter
(Can be shared by multiple projects and families, exported to ODBC, and S e e e
appear in schedules and tags) _| MEP Fabrication Pipework
| Model Groups
= | Nurse Call Devices
Select... ' | Parking
Parameter Data L Pars :
5 _| Pipe Accessories
fiarme; | Pipe Fitings
_| Pipe Insulations
Pi i !
Discipline: O Instance | Pipe Placeholders
= _| Pipes
Common

Hide un-checked categories

Kunta

Type

_| Piping Systems
© Values are aligned per group type _| Pianting
| Plumbing Equipment
_] Plumbing Fixtures
| Project Information
_| Railings

_| Ramps

Tooltip Description:

Rahar Shana

Data Type:
s Values can vary by group instance

Group parameter under:
IFC Parameters

Check All Check None

Add to all elements in the selected

oK Cancel Help
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Nyt uusi ominaisuus nakyy Projektitiedoissa, ja se tarvitsee arvon. Tassa tapauksessa: 186 - Jarvenpaa

¢ Valikon polku:
Manage > Project Information

Project Information x
Family: System Family: Project Information - Load...
Type: v Edit Type...

Instance Parameters - Control selected or to-be-created instance

Parameter Value

Organization Name Organization Name
Organization Description Organization Description
Building Name .Building Name |
Author

IfcSite GUID

IfcBuilding GUID

IfeProject GUID

Kunta

Route Analysis Settings

Praject Issue Date Issue Date

Project Status Project Status

Client Name Client Name

Project Address Enter address here
Project Name 'Project Name
Project Number .Pruject Number

[ x ] om

Jatketaan nyt samaa prosessia seuraaville ominaisuuksille, jotka sijoitetaan eri hierarkiatasoille
ja entiteetteihin.
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1.2 Seuraava taso: IfcBuilding

@ Lisaa seuraavat parametrit Revitissa:
Suunnitteluala = Fl_Suunnittelija (New Group), Suunnitteluala (New Parameter)
v Data Type: Text (IfcLabel)

v Hierarkian taso:IfcBuilding (m&aritamme tason myéhemmin User Defined Property Setin kautta)
v Esimerkin arvo: ARK

¢ Valikon polku:
Manage > Shared Parameters > New Group > New Parameter

Edit Shared Parameters X

Shared parameter file:

C:\Yordi_Documents_LOCAL\Teriojantie 6\Teriojan Browse... Create...

Parameter group:

FI_Suunnittelija ~

Parameters:

p Parameters
Suunnitteluala

New...
Properties...
Move...
Delete

Groups

New...
Rename...

Delete

Valikon polku:

Manage > Project Parameters > New Parameter > Parameter Type > Shared Parameter > Select
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Valitse alasvetovalikosta ryhma FI_Suunnittelija ja Suunnitteluala-parametri.

Shared Parameters
Choose a parameter group, and a parameter.

Parameter group:

FI_Suunnittelija v

Parameters:

Suunnitteluala

e

Edit...

Help

Maaritad tama parametri luokalle Project Information.

Parameter Properties

Parameter Type

Project parameter

Shared parameter

Parameter Data
Name:

Suunnitteluala Type

Discipline: Instance

Common

Data Type: © Values are aligned per group type

Text

Group parameter under:
IFC Parameters

Tooltip Description:

Add to all elements in the selected categories

_)Values can vary by group instance

Categories
Category name search:

Filter list: | <multiple>

("] Hide un-checked categories

+

OK

__| MEP Fabrication Hangers
| MEP Fabrication Pipework
_| Model Groups

] Nurse Call Devices

| Parking

1 Pans

_| Pipe Accessories

] Pipe Fitings

_| Pipe Insulations

_| Pipe Placeholders

_| Pipes I
| Piping Systems

| Planting

] Plumbing Equipment

| Plumbing Fixtures

“
] Railings
| Ramne
Check All Check None
Cancel Help

17.03.2025
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Kirjoita suunnittelualassa arvoksi ARK.

Project Information

Family: System Family: Project Information v foed
Type: i Edit Type...
Instance Parameters - Control selected or to-be-created instance

Parameter Value
Identity Data
Organization Name Organization Name
Organization Description Organization Description
Building Name Building Name
Author
IFC Parameters
IfcSite GUID
IfcBuilding GUID
IfcProject GUID
Kunta 183 - Jarvenpad
Suunnitteluala ARK
Route Analysis
Route Analysis Settings Edit...
Other
Project Issue Date Issue Date
Project Status Project Status
Client Name Client Name
Project Address Enter address here
Project Name Project Name

Cancel

17.03.2025

Jatketaan nyt samaa prosessia seuraaville ominaisuuksille, jotka sijoitetaan eri hierarkiatasoille

ja entiteetteihin. Luokat ovat erilaisia, ja myos hierarkiataso muuttuu, joten sy6ta arvot

huolellisesti, jotta ne ovat oikein.

Jarvenpaan kaupunki e PL 41, 04401 Jarvenpaa ¢ Vaihde (09) 27 191 e www.jarvenpaa.fi



Jérvenpad

HYVINKAR

1.2.1 Koordinaatit (ETRS89-GK25)

v Itdkoordinaatti: FI_RakennuksenSijainti (New Group),

Itdkoordinaattit_ETRS89-GK25 (New Parameter)
v Pohjoiskoordinaatti: FI_RakennuksenSijainti,

Pohjoiskoordinaattit ETRS89-GK25 (New Parameter)

v Hierarkian taso: IfcBuilding

v Esimerkkeji arvoista: 25504524.239 m, 6704386.689 m

¢ Category: Project Information

Project Information X
Family: System Family: Project Information v foadm
Type: ~ Edit Type...
Instance Parameters - Control selected or to-be-created instance

Parameter Value -
Identity Data :
Organization Name Organization Name
Organization Description Organization Description
Building Name Building Name
Author
IFC Parameters ’
IfcSite GUID
IfcBuilding GUID
IfcProject GUID
Itakoordinaatit_ETRS89-GK25
Pohjoiskoordinaatit_ ETRS89-GK25 6704386.689 m
Suunnitteluala ARK
Route Analysis :
Route Analysis Settings Edit...
Other :
Project Issue Date Issue Date
Project Status Project Status
Client Name Client Name
Project Address Enter address here
Praiect Name Praiect Name v

Cancel

17.03.2025
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1.3 Seuraava taso: IfcSpace

@ Lisaa IfcSpace-attribuutit Revitissa:

[11.3.1 Kayttotarkoitus - FI_Huoneisto (New Group), Kayttotarkoitus (New Parameter)
v Data Type: Text (IfcLabel)

v Hierarkian taso: IfcSpace

v Esimerkin arvo: Asunnot

¢ Category: Rooms (valinnainen: Areas, Spaces)

Properties

X {30} [ L1 - Working x
n ‘ ‘ I

N

uone

Rooms (1)
Department g
Base Finish =
Ceiling Finish
Wall Finish
Floor Finish
Occupant

Phasing

New Constructior | 1‘/ "ir
. N e
IFC Parameters - S

Export to IFC By Type i Huone 2 Huone 3
Export to IFC As

IFC Predefined Type

.
i N

101 102

IfeGUID 2wsI$NB2LDeAZYrd6zr_da < I
Kayttotarkoitus ‘Asunnot I

Other : \ /
Ceiling Height f
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1.4 Seuraava taso: IfcWall

# Seindn ominaisuuksien maarittaminen Revitissa:
1.4.1 LoadBearing - Pset_Wall_Testi.LoadBearing

v Data Type: YES/NO (IfcBoolean)
v Hierarkian taso: IfcWall
v Esimerkin arvo:TRUE/FALSE

¢ Category > Walls

1.4.2 Compartmentation - Pset_Wall_Testi.Compartmentation

v Data Type: YES/NO (IfcBoolean)
v Hierarkian taso: IfcWall
v Esimerkin arvo:TRUE/FALSE

¢ Category > Walls

Properties

X @ 3o} x

Basic Wall
Generic - 200mm

Walls (1)

Identity Data
Image
Comments
Mark

Phasing
Phase Created New Construction
Phase Demolished None
IFC Parameters
Export to IFC By Type
Export to IFC As
IFC Predefined Type

v B8 Edit Type

1fcGUID 1PK$ZIvY{BIgBBLC1tXoSF
Compartmentation

FireRating [E120

LoadBearing | /|

= 2l il

11

17.03.2025
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1.5 Lopullinen ominaisuus - FireRating

& Kayta FireRatingia useisiin Revitin elementteihin:
1.5.1 FireRating - Pset_Wall_Testi.FireRating, Pset_Windo_Testi.FireRating,
Pset_Door_Testi.FireRating

v Data Type: Text (IfcLabel)

v Hierarkian taso: IfcWall, IfcWindow, IfcDoor

Vv Esimerkin arvo: EI60

¢ Category > Walls, Windows, Doors

Properties

%| @ 20} x

M_Door-Passage-Single-Vision_Lite
750 % 2000mm

Doors (1)
Image
Comments
Mark
Phasing
Phase Created
Phase Demolished
IFC Parameters
IFC Predefined Type
Export 1o IFC As
Export to [FC
IfeGUID
Comparimentation
FireRating
Other

—HE

Properties

100

New Construction

None

By Type
2NgYnJOTZ6DVKKIIMEEH3S

~ BEdit Type

X @ @0} x

M_Window-Casement-Double
1400 x 1800mm

Windows (1)
Mark

Phasing
Phase Created
Phase Demolished

IFC Parameters
IFC Predefined Type
Export to IFC As
Export to IFC
1feGUID
FireRating

Other

Head Height
Finish

Glazing Thickness
Glazing Type

S HE

105

New Construction
None

By Type
2NgYnI0TZ6DVKKIIMeEHG

~ & Edit Type

EIG0

2700.000

* ck&c%“’q,[ﬂ m g #J
2 0 \"’k.,? - py””ﬂ

2 .y

ey,
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2 — User Defined Property Sets - Kayttajan maarittamat ominaisuusryhmat

Tama on osa, jossa luomme txt-tiedoston, joka kartoittaa tarkalleen haluamasi parametrit, se
sijoittaa ne hierarkiaan ja tarvitsemiimme kokonaisuuksiin, ja lopussa meilla on taysin toimiva
IFC-tiedosto, jossa on vaaditut ominaisuusjoukot. Luo uusi tekstiasiakirja muistiossa ja kirjoita
muistiin IFC-ominaisuusjoukkojarjestelma, jossa on 6 elementtia, joita tarvitaan
ominaisuusjoukkoa kohden, erotettu tabulaattorilla. Voit kopioida sen tasta esimerkista:

PropertySet:  Fl_Kiinteistd | IfcSite
Kunta IfcLabel

PropertySet:  FI_Suunnittelija | IfcBuilding
Suunnitteluala IfcLabel

PropertySet:  Fl_RakennuksenSijainti | IfcBuilding
Itdkoordinaatti IfcLabel ltdkoordinaatit ETRS89-GK25
Pohjoiskoordinaatti IfcLabel Pohjoiskoordinaatit_ ETRS89-GK25

PropertySet:  FI_Huoneisto | IfcSpace
Kayttotarkoitus IfcLabel

PropertySet:  Pset_Wall_Testil IfcWall
LoadBearing  IfcBoolean
Compartmentation IfcBoolean
FireRating IfcLabel

PropertySet:  Pset_Window_Testi I IfcWindow
FireRating IfcLabel

PropertySet:  Pset_Door_Testi | IfcDoor
FireRating IfcLabel

Tallenna se esimerkiksi nimella “Custom_property_sets_1.txt”

Jarvenpaan kaupunki e PL 41, 04401 Jarvenpaa ¢ Vaihde (09) 27 191 e www.jarvenpaa.fi



14

Jérvenpad > 17.03.2025
HYVINKARA

2.1 Revitissa “Export IFC common property sets” on oletusarvoisesti kaytossa. Juuri tekemallemme
mukautetulle ominaisuusjoukolle meiddan on vietava IFC ottamalla kdyttéon vaihtoehto “Export user

defined property sets”.
Valitse tiedosto “Custom_property_sets_1.txt”.

Maodify Setup X

<In-Session Setup> General | Additional Content Property Sets | Level of Detail | Advanced = Geographic Reference

5 . . )
<IFC 2x3 Coordination View 2.0 Setup> Export Revit property sets
<IFC 2x3 Coordination View Setup> N

. +| Export IFC common property sets
<IFC 2x3 GSA Concept Design BIM 2010 Setup .
. __| Export base quantities
<IFC 2x3 Basic FM Handover View Setup> e il
xport material property sets

<IFC 2x2 Coordination View Setup> ) P property
<IFC2x3 COBie 2.4 Design Deliverable View Se . Ex?m schedules as property sets
<IFCA Reference View [Architecture] Setup> | Export only schedules containing IFC, Pset, or Common in the title
<|FC4 Reference View [Structural] Setup> | Export user defined property sets
<IFC4 Reference View [BuildingService] Setup: [ Allow use of type properties in instance property sets
<IFCA Design Transfer View [Unofficiall Setup C\ProgramData\Autodesk\ApplicationPlugins\IFC 2025.bund\E\Comems\EOES'\Dc{ Browse ...
<IFC4x3 Setup>
<|FC-5G Regulatory Requirements View Setup | Export parameter mapping table

Classification Settings...

Reset OK Cancel

&
=
¥
§
¥

¢ Valikon polku:
File > Export > IFC > Modify Setup > Property Sets > Export user defined property sets

2.2 IFC:nvienti ja testaus Solibrissa

¢ Vie ja tarkista IFC-tiedot Solibrissa:
2.2.1 Vie IFC4-muodossa Revitista (File > Export > IFC)

2.2.2 Avaa IFC-tiedosto Solibrissa
2.2.3 Tarkista ominaisuusjoukot Solibrin "Info"-valilehdelta, jossa hierarkiapuu ndyttaa

tiedostorakenteen.
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2.2.4 Tontilla on IFC-ominaisuus Kunta jolla on arvona “186 - Jarvenpaa”, Fl_Kiinteisto -
ominaisuusryhmassa.

@ MALLIPUU Rl AO®3 B & 30

Versio &
v | Project5A1

v B Project Number

v & Default
v (D Building Name

rau

» B2
© INFO < w e 8
& Default
BIM-tiedot IFC-standardiominaisuudet Muut ominaisuudet Suosikit
FI_Kiinteistd

Ominaisuus Arvo

Kunta 186 - Jarvenpaa

2.2.5 Rakennuksella on IFC-ominaisuudet Itdkoordinaatti, Pohjoiskoordinaatti, joilla on arvoina
ETRSGK-25 koordinaatit metreina, FI_RakennusSijainti - ominaisuusryhmassa.

@ MALLIPUU

Pl 0686 @3
Versio 67
* |0 Project5A1
* [2) Project Number
* & Default
* (P Building Name
rBu
P B2
Q@ INFO - @

(P Building Name

BIM-tiedot IFC-standardiominaisuudet Muut ominaisuudet Suosikit

FI_RakennuksenSijainti FI_Suunnittelija

Ominaisuus

Itakoordinaatti 25504524.239 m
Pohjoiskoordinaatti 6704386.689 m
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2.2.6 Rakennuksella on IFC-ominaisuus Suunnitteluala, jolla on “ARK” arvona, FI_Siinnittelija -
ominaisuusryhmassa.

@ MALLIPUU RPEBR AOBO 6 & 30

Versio &
v Q| ProjectS5A1
B Project Number
v & Default
v (@ Building Name
*rau
*r 32

© INFO <w @ B
@ Building Name

BIM-tiedot IFC-standardiominaisuudet Muut ominaisuudet Suosikit

FI_RakennuksenSijainti FI_Suunnittelija

Ominaisuus Arvo

Suunnitteluala ARK

2.2.7 Tiloilla on IFC-ominaisuus Kayttotarkoitus jolla on arvona “Asunnot”, FI_Huoneisto -
ominaisuusryhmassa.

@ MALLIPUU Tk 6660 &30
Versio @
» [ Objekti
» Do
» [ seina
v D Tila

» @ Tila.1.1 : Huone 1[100)
» @ Tila.1.2: Huone 3(102)
» @ Tila.1.3: Huone 2(101]

© INFO & O06
@ Tila.1.1 : Huone 1(100)
BIM-tiedot IFC-standardiominaisuudet Muut ominaisuudet Suosikit

FI_Huoneisto

Ominaisuus Arvo

Kayttotarkoitus Asunnot
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2.2.8 Valiseinalla on IFC-ominaisuudet Compartmentation, LoadBearing jolla on boleaantietotyypi -

arvona “Tosi”, ja IFC-ominaisuus FireRating jolla on EI60 arvona, Pset_Wall_Testi -
ominaisuusryhmassa.

@ MALLIPUU Rilsle 066 &30
versio |
v (@ Project582
v @ Project Number
¥ & Default
* (D Building Name
@
» B2

@ INFO s <y @ AOG B
Y Sein4.1.5

BIM-tiedot IFC-standardiominaisuudet Suosikit

Pset_EnvironmentallmpactIndicators Pset_ReinforcementBarPitchOfWall

Pset Wall_Testi Pset_WallCommon

Ominaisuus

Arvo
Compartmentation Tosi
FireRating EI60
LoadBearing Tosi

2.2.9 Ikkunoilla on IFC-ominaisuus FireRating jolla on arvona ”EI60”, Pset_Window_Testi -
ominaisuusryhmassa.

@ MALLIPUU Rzl 2008 &3

versio &
v Q) Project582

v [ Project Number

¥ <& Default
v (D Building Name
L =NE]
3
© INFO t <> "B AOBG O
B Ikkuna.13
BIM-tiedot IFC-stand i Muut Suosikit

Pset_Environmentallmpactindicators Pset_ Window_Testi Pset_WindowCommon

Ominaisuus Arvo

FireRating El60
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2.2.10 Ovilla on IFC-ominaisuus FireRating jolla on arvona “EI60”, Pset_Door_Testi -
ominaisuusryhmassa.

@ MALLIPUU Rl 606 &30
Versio
3 Project5B2
v [3 Project Number
¥ & Default
¥ (D Building Name
r3u
L= Rv
D INFO (v ® 506
0 ovi12

BIM-tiedot IFC- dard d Muut

Suosikit

Pset_Door_Testi Pset_DoorCommon Pset_Environmentallmpactindicators

Ominaisuus Arvo

FireRating EI90

2.3 Miksi kayttaa jaettuja parametreja (projektiparametrien sijaan)?

Voidaan kayttaa kaikissa projekteissa — valttaa toistoa
Mahdollistaa automaattisen ja jasennellyn IFC-viennin

Yksi selked menetelma — yksinkertaistaa rakennuslupien kasittelya ja Solibri-verifiointia

# Yhteenveto — Miksi tima menetelma?

v Tarkka ja toistettava tapa vieda IFC-tietoja
v Helppo ja looginen menetelma kayttajille

v Solibrissa ei tarvita manuaalisia saatdja Parametrit luodaan kerran
Vv Kayta niita kaikissa projekteissa

Lisatietoja:
Yordi Lara-Ochoa

Tietomallikoordinaattori / Arkkitehti SAFA
Jarvenpaan kaupunki
yordi.laraochoa@jarvenpaa.fi
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